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In association with Eastern Arizona College

Cooperative Education I
Course Information:

Course Prefix/Number:  
COE 111




Dept/Course Title: 
Cooperative Education I
Class Days/Times/Room:  
TBA





Credit Hours:  

1







Prerequisites:  

None

Required Assessments:  
Portfolio
Teaching Format:  
15 hours of work per week per 1 credit registered
Methodology:
This is a self-paced course and designed to help students develop job seeking strategies, secure a position, write for scholarships and/or admission applications to continue your education.  
Instructor Information:
Name:
Cindy Barnes 


US Mail:
Gila Community College/San Carlos Campus 
Tonto & Mesa Drive
San Carlos, AZ 85550
Phone/Voice Mail:    (928) 475-5981
E-mail: cindy.barnes@eac.edu 
URL:
http://teach2.eac.edu/barnes/index.htm 

Availability:  Home (928) 428-2871 or email anytime
Office hours: I will be on campus from 7:30am – 3:30pm any questions or concerns please contact me in person, email or home phone.  
Cooperative Education I

Course Syllabus

Instructional Materials: 
File storage center that accommodates hanging letter-size folders

E-mail account with appropriate e-mail address

Box of thank-you notes (white or ivory, businesslike)

Book of postage stamps, most businesslike available
· Required Text: None
· Others:  One blank 3 ½-inch floppy disk, or 1 zip, or 1 USB smart drive.  Start good backup habits early and you won't kick yourself later when your files are lost.  
· It may be helpful to have a notebook to take notes or to keep class assignments and a pocket folder for handouts. 

· Browser Microsoft Internet Explorer or Netscape Navigator 7.0 or higher. Operating System: Windows 98/XP/03 or some compatible system. If you do not have Microsoft Word, please save documents as rich text format when you send materials to the instructor electronically.
· The learner is required to submit an e-mail address to the instructor that will be used during the extent of the course. I check e-mail daily.  I will respond within 24 hours by e-mail.
· Note: The Gila Community College Bookstore can be accessed and books ordered via the Internet at www.gilaccc.org.
Educational Value

A. To general education:  Student recognizes and credits on the job experiences as a valid component of the educational program.
B. To other courses or curricula:  Cooperative Education is required for some certificates and AAS degrees and is an elective for other certificates and AAS degrees.  

C. Provide you with the information you will need as you embark on a major change in your life - deciding on and attending a college to enhance your career choice.  
Description

Eastern Arizona College offers cooperative education courses for students who have selected a career objective.  Designed to give students the opportunity to learn through supervised work experiences, the courses integrate students' educational activities with on the job learning opportunities.

Meetings with the Coordinator are designed to assist students in identifying activities (competencies they will complete on the job, learning job survival can improve skills and develop effective human relations and communications skills.  

Included in the lessons is information to help you prepare for college, select a college, ease the transition to college, and manage the changes in your life that occur during college.  
Course Objectives:  What you will learn as you master the competency:
· Achieve an acceptable level of technical skills
· Display attitudes appropriate to the work environment

· Accept responsibility for regular attendance

· Articulate the importance of continuous career development

· Formulate a career plan

Course Requirements:    In order to successfully complete this course, student must attend class and keep pace with lab and homework assignments.  
Important Phone Numbers:

Gila Pueblo Campus: 928-425-8481 San Carlos Campus:  928 475-5981 San Carlos High: 928 475-2378
CLASS ENVIRONMENT
The outline and structure of this course creates a set of common expectations for your work. Here are some general considerations I wish to emphasize:

· Attendance:  Manage your time well is crucial if you are to achieve success on the job or in college. Try to meet deadlines for projects and daily activities. Prioritize your activities. Create a balance between personal responsibilities and those of the job. Overall, you should try to effectively manage all the information which comes to you. Managing your time well will increase productivity. This will result in a high level of satisfaction, thereby reducing stress and increasing your level of motivation.
· Workload:  Students are expected to spend an average of 9 hours per week attending class sessions, doing assignments and research, reading and preparing for exams.  The standard Carnegie Unit of college credit assigns one credit hour for each 15 hours of class time and assumes that students spend two hours working outside the classroom for each hour of classroom instruction.  For a three-credit course, this translates to 135 hours per semester or an average of nine hours per week for a 16-week semester.
· Guidelines:  Please read all guidelines for Eastern Arizona College. You will be responsible for knowing the guidelines, policies, and procedures of Eastern Arizona College. The information can be found at the Eastern Arizona College website http://eac.edu/ 

· Classroom Behavior:  Students creating disturbances that interfere with the conduct of the class or the learning of others will be asked to leave.

· Relationship:  The relationship between learner and coordinator is important. While coordinators are responsible for providing course content, we also serve as mentors to assist in your continuing education and socialization into the profession of business. Feel free to discuss your particular needs with me.

· Philosophy:  I believe your educational experiences should be both beneficial and enjoyable.  I believe the ideal attainable situation is one where the students and the instructor look forward to class with eager anticipation.  The only way this can be attained is through class preparation by everyone and a permissive class atmosphere.  
Cooperative Education I

COE 111 Grading Policies

Academic Integrity: 
· Violations of scholastic ethics are considered serious offenses by Eastern Arizona College, the Business Department and by your coordinator. Students may consult the EAC Student Handbook sections on student code of conduct, on scholastic ethics and on the grade appeal procedure.  Copies are available at GCC campus library.

· All work done for this class must be your own.  While you may discuss assignments with other class members, the final written project must clearly be your own.  You may use work from books and other materials if it is properly cited.  Copying from a book without proper reference or from a person under any circumstances will result in an F for the assignment, and at the instructor's discretion, possibly an F for the course.

· Students are expected to abide by the Student Code of Conduct and the Scholastic Code of Conduct found in the Eastern Arizona College Student Handbook. Copies are available at GCC campus library.

ADA Compliance: 

Gila Community College District strives to comply with the provisions of the Americans with Disabilities Act and Section 504 of the Rehabilitation Act. Students with disabilities requiring special accommodations must notify the instructor of this need or directly contact the Disabled Student Resources Office on your campus at the beginning of the semester. 

Classroom Behavior: 

· Because of insurance limitations, non-registered visitors are not allowed at class sessions or on field trips.

· Possession of drugs, alcohol or firearms on college property is illegal.

· Eating, drinking, smoking and soliciting are not allowed in classrooms.

· Pets, telephones, pagers and other electronic devices that distract students are not allowed in classrooms.
· Students creating disturbances that interfere with the conduct of the class or the learning of others will be asked to leave.
Coordinator Withdrawals:  

The last day for a student to initiate an official withdrawal from a semester-length course and receive a “W” grade is six weeks prior to the last Friday before final exams.  The instructor will not initiate a withdrawal from a semester-length course.  It is the student’s responsibility to withdraw from their course, not the instructors.  Withdrawal for Short-Term and Open-Entry Exit course is the last day of the class.
I find grading the most difficult of all teaching tasks.  However, I have a responsibility to evaluate a student’s academic performance.  Accordingly, grading rationale will be calculated as follows:
	Assignments 
	Points
	

	Forms & Worksheets
	   385
	

	College Goal Sunday
	50
	

	Lessons
	 100
	

	Reports
	75
	

	Career Fair
	60
	

	Virtual Field Trip
	   310
	

	Community Service
	265
	

	Research/Personal Development
	80
	

	Total Points 
	1325 
	


A standard scale is used for the final grade.

Grading Scale

A 
1186-1325 points
B 
1054-1185 points
C 
 921-1053 points
D 
 795-920 points
F
  0-794 points 
   
Ultimately your grade will be based upon the above and your initiative to pursue further studies, such as excellent communication and interpersonal skills, decision making and problem solving.
Make-up Exams:  Your exam is exercising a high level of dedication and commitment to your future.  You should be seen as possessing positive work attitudes
Extra Credit Opportunities:  Portray a positive image of yourself.  Punctuality, regular attendance, teamwork, dedication and commitment will be considered for extra credit.
Final Grades:  Final grades can be requested by contacting the EAC Records and Registration Office at 1-800-678-3808, ext. 8270.  On Line:  Log on to www.gilaccc.org and lick on Gila Hank Online to access GCC/EAC’s real time internet registration system. For more information contact GCC administrative offices at 425-8481 

Not an Easy Class--While this class isn't rocket science, it's not necessarily easy, as some students have the misconception that it will be. This class has a heavy workload and it requires hours of reading and research to make sure you understand what is available to you. All this considered, if you were looking for an "easy A," this may not be the course for that.

Cooperative Education COE 111
 Class Calendar/Schedule 

“SUCCESS IS THE ONLY OPTION”

I hear and I forget. I see and I remember. I do and I understand.
-- Confucius, 551-479 B.C.

Housekeeping: A Cooperative Ed Power Point will be shown to emphasize what this class is about. 
Please email me cindy.barnes@eac.edu with the following information:  (If you do not have an email address please create one in Yahoo.  (Write down your ID and Password and save it).  
Name

Course Number in Subject Line (i.e., COE 111)

Course expectations

Work experience 

Educational background

Anything else you would like the instructor to know about you 
Additional Reading on Email:
· Email Netiquette: http://www.onlinenetiquette.com/netiquette_101.html (email this link to yourself as a reference)

· Quiz: http://www.onlinenetiquette.com/netiquette_quiz.html (Give instructor your score to record)

· Sign up for Email Tips: http://www.onlinenetiquette.com/netiquette-tips.html 

· Emoticons:http://www.mit.edu:8001/people/cordelia/smileys.html 

· Read and sign syllabus that can be found online http://teach2.eac.edu/barnes/toc.htm 

· Familiarize yourself with my website http://teach2.eac.edu/barnes/index.htm as I refer to the many resources available.  
· Most of this class will be web based material.  

· Create a folder on your computer and call it your name.  
· Create a folder on your yahoo/hotmail account to file emails and information about this class.  

· Let's talk about calendars.  
All of your assignments need to be emailed to me as an attachment.  In the subject line please put the name of the class COE 111, within the email tell me what the assignment is and then of course attach the document
Let’s get ready for class!

The following class schedule is developed as a guide and may change at the discretion of the coordinator.   How fast the class goes and how well we cover the topics hinges on the class’ ability to absorb the material and completing the tasks.  This course is designed for the student to take an active roll in their learning.  As technology increases so does the need to read and write more proficiently.  PLEASE ASK QUESTIONS SO YOU CAN BECOME MORE PROFIECIENT.     

. 
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This signifies a new assignment.  Please keep track of what you have completed and what 
      you need to complete.  This is your career & life so take some responsibility.
	Week 1 – 3
8/13-8/31
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	1. Introductions and Pretest – College courses always require pretests.  
2. Let's go over some expectations of this class with a Power Point Presentation.  

3. Complete the student coop application – Once Coop coordinator has your email address the forms can be sent to you. 
4. Signed syllabus 
5. Discuss and join FBLA as a valuable organization for your college/work applications and resume.  http://www.azfbla.org/azfbla/2007-2008/calendar.php 
Sign on to Career Cruising www.careercruising.com 
Username is sancarlos
Password is 85550
Activity 1
Create an online career and education portfolio that you can update, expand, modify, or print at any time.  If you have a portfolio you can skip the next three steps.  
· From the Main screen, click PORTFOLIO in the menu bar. Then click NEW PORTFOLIO. 

· Enter your information. Use your email login for your Portfolio Username and your email password for the Password.  If you use the same username and password in many places you won't forget.  (Be sure and put in your complete email address so your username and password will be emailed to you)

· Your portfolio has been created, and you will save information to it as you complete additional activities. 

You can go to Helpful Information/Resources for Advisors & teachers and then download the MS Word form of the portfolio.  Save the packet on your computer. 
2. Saving Your Career Matchmaker Results shows students how to save their assessment results to their portfolio.

3. Careers That Interest Me allow students to save careers that they are considering to their portfolio and record their thoughts about these careers.

4. Schools That Interest Me helps students find schools that offer the education and training they need to pursue their career goals and save those schools to their portfolio.

5. High School Education Plan helps students create a personalized high school education plan based on their career interests.

6. Career Preparation and Planning shows students how to record and organize their career planning activities.

7. Abilities, Activities & Awards helps students document their extracurricular activities, skills and abilities, and the awards and certificates they have received.

8. Work and Volunteer Experience helps students document their work and volunteer experience.

9. Using the Resume Builder takes students through the process of using their career portfolio to create a professional resume.
DUE AUGUST 31, 2007 NO EXCEPTIONS (We will revisit your portfolio throughout the year)
· FBLA forms

· Coop forms

· Pretest

· Signed Syllabus

· Email to coordinator

· Portfolio

Evaluation will be based upon your completed items = 90 points

	Week 4- 6
9/4-9/20
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	1. Ask your coordinator to email or copy Career Exploration, Lesson 4 and follow the steps.  
2. After you complete steps 1 thru 4 and the activity, ask coordinator for "Completing Application" lesson.  

3. At college or the workplace you need to read and actually comprehend what you read.  Let's go through this reading lesson together http://www.careerwired.com/reading.html
4. This site is another excellent resource.  Go through all the links starting at "Getting the Job" http://www.careerwired.com/resources1.html
5. This site will also help you in your career direction http://www.vault.com/hubs/industrylist.jsp 
6. Now it's time to really think!  Everyone is required to take the practice college entrance exam.  ACT is for west coast colleges and SAT is for East coast colleges.  College & Work – Career & Life go hand in hand.  Tests are given by both employers and colleges SO GET USED TO IT.   Go to this site and enroll as a student for SAT http://www.collegeboard.com/student/testing/sat/prep_one/test.html  or go to this site for ACT http://www.actstudent.org/ Once you click the GET STARTED you may have to become a member.  Read the directions.  We won't always have the time to finish find out if your answers can saved.   

7. Please involve your coordinator on the SAT or ACT testing dates and what your plans are.

DUE SEPTEMBER 20, 2007 NO EXCEPTIONS
Email to your coordinator :

· Activities 1-4

· Complete the "How Well Do You Follow Directions" Excel Sheet
· Completed application guide

· Completed Sample Application

· Results of SAT or ACT exam
· SAT or ACT plans and/or scheduled dates

	Week 7-8
9/24-10/5
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	Now you need to focus more specifically on career and educational options that will lead you to a clear plan for achieving your post-secondary goals. This direction is gaining a realistic understanding of the educational and career options available to you and taking the important steps required achieving your goals. 
If necessary register for SAT I or ACT most colleges require SAT scores but some do not so do your homework! Here's a place to start http://sat.eknowledge.com/Information/SAT%20Article.htm or http://www.actstudent.org/ 
Make sure you have a Social Security Number. Colleges use these numbers for data processing.
Research
There are over 3,400 two and four year colleges in the United States. Some questions to consider are: 
· What do I want to study? Which schools have good programs in my major? 

· Do I need to be close to home? How far away? 

· Do I want to be in a city? The country? 

· How well have I done in school and on my college exams? What kind of student are the colleges looking for? 

· Do I want a small or big college? 
· Am I looking for specific athletic opportunities? Or any special academic services?

· Select the colleges you will apply to. Obtain and complete applications.  It is in your best interests to keep a running log of found colleges and career interests sites on your portfolio or email.  If it is in your email or portfolio you have less of a chance of loosing the information and keep it as a resource.  http://www.princetonreview.com/college/default.asp   You may also want to search for Native American Colleges http://www.aihec.org/ 
· International study - http://policy.miis.edu/docs/career/Organizations%20with%20Advertis.pdf 
· http://www.internexchange.com/ 

· Ask your coordinator for a pre made College Tracking Excel Sheet.
· Read through the Internet links on career articles and advise on Princeton Review - http://www.princetonreview.com/cte/articleIndex.asp
Decide
· Maybe you are more interested in internships, fellowships, cooperatives, summer camp and apprenticeships.  http://www.wetfeet.com/Article%20Types/Internships.aspx 

· You should apply to four to six schools 

· One school should be a "safety" school, a school we are fairly certain will accept you. We determine if a school is a safety by comparing your GPA and exam scores with previous grads who have applied. Many students use the Community Colleges as "safety" schools. They have "open admissions," which means they accept everyone, and they are very affordable. 

· One school should be a state college or university. These publicly funded schools have the most affordable tuition. All the State Colleges have minimum admissions standards. Find out what they expect as GPA or college exams.  Two or three schools should be "realistic" choices. You should also set your goals high. 

	Week 7-8 Cont.
Week 9-10
10/9-10/19
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	DUE OCTOBER 5, 2007 & WILL ACCEPT THRU OCTOBER 8TH.  
Assignment:  After reviewing the information above you should be able to determine what direction you desire after graduation.  

1. Complete and check items on an Excel check sheet for college and career.  You should have at least 4 colleges of interests.  
2. Write a 5 paragraph essay that describes your education plan, career goals and a method of accomplishing those goals in the workplace.  This career plan must encompass minimally five years of anticipated education and employment.  
3. Attach your check sheets and your career plan to your portfolio.  Please email the coordinator when this is completed for grading purposes by September 7th, so we can plan ahead.  
When I grade your written essay it will be based on the quality of substance and the business and professional style and format you use to put it together.  A paragraph is 5 sentences. I am expecting that all items will be type written, well displayed by someone ready to enter college and/or the workforce.  (Essay specifications at the end of syllabus)    
It is imperative that previous assignment be completed to move on to this next assignment.  From Activity 5 of your portfolio you stored your high school education plan by recording the courses you have taken, are taking, and plan to take in the future.  Now you need to make sure your Education Plan satisfies the following conditions:

□ Do your course selections meet the school’s graduation requirements?

□ Do your course selections meet post-secondary school prerequisites for subject areas?

□ Do your course selections meet post-secondary school prerequisites for academic level?

You need your high school transcript.  If you do not have it ask how to get it so you can make sure you are meeting graduation & college/work requirements.    
· Activity: Discuss with Guidance Counselor if coming up short with necessary points. You may have to attend night school? 

· Activity: Clarify points received from summer school wherever necessary. 

· Activity: Verify if portfolio requirements have been satisfied and your information is correct.

· Activity: Review Practice SAT or ACT scores.  Find your weaknesses and ask the coordinator what resources are available for you to gain strengths.   

· Activity: Reinforce need to visit College for information. If you are planning on attending college, joining the military or workforce next year, make sure you know what is involved in applying. 

· Activity: Stress the need to continue to excel even if past high school grades have not been the best. 

· Activity: Do you need experience of internships, volunteer work or employment to put on your applications/resume.  Ask your coordinator and/or parents for directions.   

· Activity: Develop outline for college/scholarship essay or cover letter for job application. 

· Activity: Review your resume in Career Cruising, be sure to list your Career & Technical Education (i.e., nursing, business, construction) programs or career choice. 



	Week 9-10

Continued

	DUE OCTOBER 19, 2007 - A written report of the following items:

· Introductory paragraph of your academic progress, work experience, strengths & weakness' and how you plan to excel to meet your goals.  Second paragraph summarize how or what you need to do to perform in a highly skilled workforce.
· Create a table showing all your classes and grades for each high school year.

· Copy your resume on a separate page within this document.  

· Conclusion should state why a college or employer should accept you.  If it's because you work hard or learn fast, state facts to support your work or learning.    

	Week 11-15
10/22-11/20
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This section may take several weeks to finish.  By Thanksgiving you need to complete everything.  

	A fool and his money are soon parted...  
Figuring out how to make money is one thing...  Knowing how to make the most of what you make is another!  People with average (even modest) incomes can learn to be smart, get out of debt and retire rich.  The most important thing is for students to start now.  
1. Ask the coordinator for Career lesson 8 to follow along with the reading assignment.   

2. Go to the San Carlos High Webpage, click on Braves Info, Student Resources, and Finance then find the Finance FREAK link.  Have students save this site on their favorites.  http://www.financefreak.com/ 
3. If needed this site will assist students with an Excel Tutorial at this website: http://usd.edu/trio/tut/excel/index.html
Assignment: DUE NOVEMBER 20, 2007 

Students will be evaluated on their 

vocabulary words = 25 points

Created checks = 10 points 

Chosen stock information = 15 points 

Excel checkbook/budget/car payment = 75 points

TOTAL = 125 points 

Be sure and attach your checkbook on your portfolio



Office of Indian Education Programs at the Bureau of Indian Affairs provides 


The United States Office of Personnel Management (OPM) E-Scholar Web site 

	1. provides all students, parents, and career professionals with information on different educational opportunities offered by Federal Government departments The site includes information on scholarships, grants, internships, fellowships, cooperatives, and apprenticeships http://www.studentjobs.gov/e-scholar.asp 
2. Search for other sites with information on Internships, Fellowships, and Study abroad. Apprenticeships  and/or Summer Camps

This is just a few I found on Yahoo.  If you find something valuable please share to I can put on our website and in this syllabus for next year.
	

	Week 16-19

Continued

11/26-12/20
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Week 22
Continued

1/7-1/11
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	DUE DECEMBER 20, 2007 – 

· Start the application process for your chosen direction (i.e. scholarships, internships, cooperatives, apprenticeships, summer camps, peace corp.)
· Use College Organizer 

· Check college application deadlines.
· Scholarship deadlines and requirements 

· Check financial aid deadlines.
· Check to see if your colleges require interviews 

· Make appointments if required. Most out-of-state colleges will have an admissions representative in your area 

· Try to visit colleges. You can call the admissions office for a time to take a campus tour and attend an information session.

· Ask your English teacher and counselor to review the draft of your essay or cover letters. Your essay should illustrate your uniqueness. It should be typed and grammatically correct. 

· If you need recommendations ask two teachers who like you and respect your work. Make sure to give them two weeks notice. 

· Complete college applications. *Many selective colleges have January 1 deadlines. 

· If eligible, you may request a fee waiver, for example New Mexico
· Keep copies

· Bring completed college applications to the coordinator with addressed, stamped envelopes. (2 stamps) They will mail them with your transcript, report card, school profile and letters of recommendation.

January – It's time to get crackin'

· What announcements and confirmations do we need to make for College Goal Sunday? (January 1 is the first day it can be sent). 

· Check your college or job check sheet to meet deadlines
· Complete your scholarships and essays. 

· If you are thinking that you may play Division One or Two Athletics, you must fill out a "NCAA Clearinghouse Form."
· If you are thinking about the military what is your ASVAB status.  Can you retake the test to improve your score?
· If you are interested in Job Shadowing ask coordinator for Career Lesson 9
IF YOU THINK YOU ARE DONE WITH EVERYTHING – THINK AGAIN!  THERE IS ALWAYS ROOM FOR IMPROVEMENT TALK TO YOUR COORDINATOR.


	Week 23-24
1/14-1/25
[image: image11.png]&




Week 25

1/28-2/1
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Week 26-27
Continued

2/4-2/15
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	Continue working on your personal development 

· Personal improvement plan from your coordinator

· College requirements

· Obtaining a job

· Assigned project by your coordinator

· Men over 18 must register for the draft. You will not be eligible for federal aid until you do.
· Make sure to tell your parents to get their taxes done ASAP!
Personal Development 25 points
 Research = 25 points
 AFTER COLLEGE GOAL SUNDAY
You will receive your SAR about 4-6 weeks after filing your FAFSA. You must check the information carefully for accuracy. If there are mistakes, you must make the corrections and send it back. Keep a copy.

· Bring in your SAR when you receive it. 

· Your college will mail your financial aid package in two-four weeks after receiving an acceptance letter. You need to review it with your family and your coordinator. You need to decide whether or not to take out the loans. 

· Try to visit the colleges that have accepted you. Most will have special programs for "accepted" students. Many will give you an opportunity to spend a night on campus and attend classes.
Attendance to College Goal Sunday is worth 50 points (Even if you don't plan to go to college I would like you to attend – YOU NEVER KNOW….)

Now your assignment is to land your cooperative education job
If you have not secured a cooperative ed position, then it is time to improve our interviewing skills.  

1. Let's watch some videos on professional communication and dress.  

2. As a class please go to this site http://www.quintcareers.com/dress_for_success.html 

3. Go to this site to review possible questions they should ask the supervisor.  http://www.quintcareers.com/information_interview.html  Read the available information on this website.  
Ask coordinator for career lesson 11.  

4. Go through the Career Cruising activity.

5. Break into groups of 4 or more as interviewers.

6. Each student must be interviewed by a panel.  
Total points = 40

	Week 28-32
2/19-3/20
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Week 33
3/24-3/28
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	1ST SAN CARLOS CAREER FAIR 
If you would like to help the coordinator with the career fair please volunteer.  

Create and organize a community service project for us to participate after Spring Break.

In the meantime keep up with the following:
· Bring in any acceptance or rejection letters to your counselor

· Evaluate the schools that have accepted you and compare the financial aid packages. Decide! 

· Once you have decided, make sure to complete the financial aid award letter by "accepting" the aid and signing the form. 

· All schools will require a deposit, usually around May 1-15. If you need a little more time because you are waiting to hear from another college, you can request an extension. 

· Once you decide which college you will be attending, you must send a letter declining admission to all other schools that accepted you. This allows them to open a seat for another student. 

· There are still some schools looking for students. You may still send in applications... Better late than never!
Each employer or activity you participate in you will receive 10 points.  The coordinator needs the Evidence of Participation before you leave for Spring Break
Spring Break!  Your assignment is to fill out applications, submit cover letters and resumes.  You may offer volunteer services just to put more on your resume.  ESPECIALLY IF IT IS IN THE CAREER FIELD YOU WANT TO ENTER.  
The coordinator will need something in writing of what activity you accomplished over spring break.  DO NOT BURN DAYLIGHT! 



	Week 34-37
3/31-4/25
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	ARE YOU READY COLLEGE OR THE WORKPLACE?

Avoid SENIORITIS
What your mother told you about college - http://www.mtsu.edu/~chopper/mother.html 

Go through all of the virtual field trips.  When you click on a field trip you will have a word document.  Save As/whatever name/in your folder.  At the end of each trip are some questions you need to answer and submit to the coordinator.  http://www.mtsu.edu/~studskl/4evirtualfieldtrips.html 
Let's go over these PowerPoint presentations on developing quality study skills:  As we are going through the slides, take notes, there will be an assignment…http://www.mtsu.edu/~studskl/4epptchart.htm 

Found websites that may be helpful for you
Continue checking back as I will add more

What you need to do to finish college!
College Terminology
First Generation Students
Making it Count
Public speaking experience will benefit you in college and throughout your career.
Always be mindful of a safe environment
Build your vocabulary
http://syndicate.com/ 
What you need to do to keep your job!
Public speaking experience will benefit you in college and throughout your career.
Sample Interview Questions
You're still getting grades on the job
Tips on how to keep your job
Career Advise
Start your own business
Always be mindful of a safe environment
"Choose a job you love, and you will never have to work a day in your life."
—Confucius
Assignment DUE APRIL 25TH:

1. Make a list of at least 10 most useful tools you found from the PowerPoints.

2. 30 Virtual Field Trips = 300 points

	Week 38-41

4/28-5/28
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	COMMUNITY SERVICE – Here are several website that teaches students about the various purposes of non-profit organizations. These sites are very informative and have links for both "Kids & Teens," and "Teachers." A great site for students to explore numerous aspects of non-profit organizations.
http://www.idealist.org/kt/ 

http://www.hud.gov/community/index.cfm 

http://www.freethechildren.com/getinvolved/index.html 

http://www.volunteermatch.org/ 

http://www.dosomething.org/ 

http://www.leadershipburbank.org/gardenproject.htm 
We need to brainstorm throughout the year on group or individual projects for you to complete.  

Placement Expectations
• All students will choose their community service project (in groups or individual).  
• There should be a weekly commitment of 4 hours given to the designated program.

• Contracts will be signed by students and coordinator detailing expectations and responsibilities of community service involvements.

Grading
The service component accounts for 25% of a student's final grade. Given the recognized limitation of time and the opportunities for service available: 

1. Took every opportunity to serve and to learn--(30+ hours)--265 pts. 

2. Made good use of opportunities to serve and to learn--(29-27 hours)--245 pts. 

3. Made average use of opportunities to serve and to learn--(26-24 hours)--200 pts. 

4. Neglected obvious opportunities to serve and to learn-- (23-20 hours)--160 pts. 

5. Irresponsible/unacceptable in level of participation and/or use of opportunities to serve and to learn--(19 hours and below)--60 pts. 

· Allowance should be given for genuine emergencies or illness. If a student feels they have to miss "work" due to illness or some other priority it will be their responsibility to inform the coordinator in advance to allow alternative arrangements to be made. 




Specifications for written papers

Margins
Since they are short, unbound reports should take up as much space on the page as possible so the margins should be 1" on the top, bottom, right and left.  Change your margins by going to File>Page Setup. 
 

Spacing
In college you always double-space, in the workplace you generally single-space.  Paragraphs will be indented.  Double-space automatically by going to Format>Paragraph and changing Line Spacing to double or by keying CTRL-2 
 

Heading
Unbound reports do not always need title pages, but for your career report you will include a title page.  You will have a heading on all pages except your title page.  In order to add a heading go to View>Header and Footer, your header should be in the right hand corner. 
Title Page Your title page should be centered vertically and horizontally (File/page setup/click on layout tab and you will see alignment).  The content may vary but will at the very least include the title of the report, the author's name and date. Most reports done in college you will include the professor's name and course name.
June 

· Graduation....Good Luck! Make sure to let us know next year how you are doing!
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Thank you for a wonderful journey! Your self-learning starts from here!

"It is good to have an end to journey toward, but it is the journey that matters in the end."
--Ursula K. LeGuin
Student Grade Sheet

      Name:




  Semester:

	Assignments 
	Points

	Forms & Worksheets
	   385

	College Goal Sunday
	50

	Lessons
	 100

	Reports
	75

	Career Fair
	60

	Virtual Field Trip
	   310

	Community Service
	265

	Research/Personal Development
	80

	Total Points 
	1325 


	I
	Forms & Worksheets
	

	II
	College Goal Sunday

	

	III
	Lesson
	

	IV
	Reports
	

	V
	Career Fair
	

	VI
	Virtual Field Trip
	

	VII
	Community Service 
	

	VIII
	Research/Personal Development
	

	IX
	Total Points
	

	X
	Final Grade
	


Cooperative Education  SYLLABUS

Caveats:  This syllabus is a written contract involving the instructor, student and the college.

Your instructor will make every attempt to follow the above procedures and schedules, but they may be changed in the event of extenuating circumstances.

Students submitting assignments through the mail are advised to make copies for their own protection.
If you move during the semester, please file a change of address form at any GCC campus registration office.

Student/Instructor Contract

Acknowledgment of Receipt of Syllabus

Please sign and return the following acknowledgment to me in class or at the following address:

Dr. Stephen Cullen
Gila Community College

Gila Pueblo Campus

Globe, AZ 85501
____I have received my Cooperative Education syllabus (including course objectives, policies, requirements and schedule) and have read and understand all the enclosed materials.           

 

____I have no objection to receiving an occasional call from the instructor at the number given with my registration materials.  







        

____I prefer that the instructor not call or contact me by phone anytime during the semester.                       



____I would like to be contacted by the instructor regarding the following concerns:

        

        
Name _______________________________________             Student ID #

         Phone




   E-mail address

�


�
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